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General Format and Layout Specifications
File Type
We prefer you to submit your work either in a Microsoft® Word file or an Adobe®
InDesign® 3, CS, or CS3 file. If your manuscript was composed in another word
processor, you can convert the file to Microsoft Word yourself. This way you can
review the document and check for conversion errors, which can appear when a
document is transferred from one program to another. If you’d feel more
comfortable having us handle the conversion, we can also accept these files,
though a conversion fee may apply in some cases:
• Corel® Word Perfect (version 8.0 or higher)
• Microsoft® Works
• Rich Text Format (RTF) documents
• Adobe® PDF
• OCR documents set in Text format.
If your manuscript is in a different format than those listed above, a CIC will
determine if the manuscript file is acceptable, or can be converted into an
acceptable format. Please note: if you have elected to utilize editorial services
during the publication process, you will need to have access to view our
suggestions and revisions in Microsoft®.
Parts of the Book
We need your manuscript to be submitted in one continuous Microsoft Word
document. Please do not save each chapter as an individual file, but submit the
entire content of the book in one document. Below you will find a list of all the
different parts of a book that can be included in the manuscript:
Front Matter:
Front matter appears before the main text and introduces your book to your
readers. Use the list of common front-matter pages below to ensure that the
parts of your book are in the correct order.
Endorsements: (if any)
Half-title page: The half title (on page i, the first recto) normally
consists only of the main title. The subtitle is omitted, and the author’s
name does not appear. The verso of the half title (page ii) is usually
blank but may contain text or an illustration, called a frontispiece.
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Card or series title page: List any of your previously published
books by title from first to most recently published. A common way to
begin this page is “Also by [author’s name] …”
Full-title page: The title page (p. iii or, if a two-page spread, pp. ii–
iii) presents the full title of the book; the subtitle, if any (note that
there should never be more than one subtitle); the name of the author,
editor, or translator; and the name and location of the publisher. If the
type size or style of the subtitle differs from that of the main title, no
colon or other mark of punctuation is needed to separate them.
Copyright page: (Provided during design) This page contains the
copyright notice, publisher’s information, printing history, country
where printed, and ISBN. The usual notice consists of three parts: the
symbol ©, the year the book is published, and the name of the
copyright owner. Please note that as the publishing industry
transitions from 10- to 13- digit ISBNs, we will assign both to your
book and each format will appear on the copyright page.
Dedication: It is not necessary to actually include the words
“Dedicated to” in a dedication. A statement like “For Casey” or “To
my mother” is more appropriate.
Epigraph: An epigraph is a quotation that is pertinent but not integral
to the book.
Table of Contents
List of Illustrations (if illustrations are included in manuscript)
List of Tables (if tables are included in manuscript)
Foreword: A foreword is usually a statement by someone other than
the author, sometimes an eminent person, whose name may be carried
on the title page (e.g., “With a Foreword by John Quincy”).
Preface: The author’s own statement about the work is usually called
a preface. Material normally contained in an author’s preface includes
reasons for undertaking the work, method of research (if this has some
bearing on readers’ understanding of the text), acknowledgments, and
sometimes permissions granted for the use of previously published
material.
Acknowledgments (if not part of the preface): If the
acknowledgments are long, they may be put in a separate section
following the preface; if a preface consists only of acknowledgments,
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the title should be changed to “Acknowledgments.”
Acknowledgments are occasionally put at the back of a book,
preceding the other matter. In multivolume works, acknowledgments
that apply to all volumes need appear only in the first volume. Should
they vary from volume to volume, separate acknowledgments may be
included in each.
Introduction (if not part of text): A substantial introduction by
someone other than the author is usually included in the front matter,
following the acknowledgments; however, if it is not more than three
to five pages, it may more appropriately be called a foreword and
placed before the preface. Material about the book—its origins, for
example—rather than about the subject matter should be included in
the preface or in the acknowledgments. Most introductions belong not
in the front matter but at the beginning of the text, paginated with
Arabic numerals.
(List of) Abbreviations or Chronology: Other items that may be
placed either in the front matter or, sometimes more suitably, in the
end matter include a list of abbreviations, a publisher’s note, a
translator’s note, and a note on editorial method.
Book Block
The main text, or what we call the body text, is the core of your manuscript.
Use the list below to ensure that the parts of your main text are in the correct
order.
Introduction: The introduction describes something about the main
text that your reader should know before proceeding to read the book.
Chapter layout: Each chapter begins at the top of a new page. The
first page of each new chapter will begin directly following the last
page of the previous chapter unless you specifically request that all
new chapters begin on the recto (right-hand) page of your book.
Epilogue: An epilogue is a brief concluding section, often addressed
directly to the reader in a work of fiction. Most epilogues continue the
story years later or update the reader on a certain character’s
whereabouts. Please do not use a chapter number for this section.

4

Afterword: The afterword is also a brief concluding section, often
used in nonfiction works. It does not need a chapter number. For
example, you may want to use the afterword to review the strategies
outlined in your book and give advice.
Conclusion: More extensive than an epilogue or afterword, a
conclusion may or may not be numbered as the final chapter. The
conclusion provides a summary of your ideas, concepts, and advice,
leaving the reader with a clear understanding of the major concepts
presented in the book and some guidelines on what to do with that
information.
About the Author: This is a short biography at the end of your main
text that summarizes (1) any expertise you have in the field in which
you are writing, (2) any previous books that you have published, and
(3) a brief summary of where you currently live, with whom you live,
and what type of work you do.
End matter
Use the list of common book block parts below to ensure that the parts of
your end matter are in the correct order.
Appendices: An appendix includes any data that might help clarify
the text for the reader but that would have disrupted the flow of the
main text had it been included earlier. Such items include a list of
references, tables, reports, background research, and sources (if not
extensive enough to be included in a separate section).
Notes: If your main text requires notes to amplify or document certain
passages throughout the text, please arrange the notes by chapter in a
notes section.
Glossary: A glossary comprises alphabetically arranged words and
their definitions. Be sure to include one if you use terminology that is
not generally known to the average reader or if you coin new words or
phrases to explain your ideas.
Resources: Often, readers want to buy products or join organizations
in the field in which you’ve written. A list of organizations and
associations, manufacturers and distributors, Web sites, and other
sources are invaluable to your readers.
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Bibliography or References: Both the bibliography and reference
sections list the sources for works used in your book. Be sure to
arrange the sources alphabetically by the author’s last name. For
samples and guidelines on proper layout, refer to the Chicago Manual
of Style.
Index: The index is an alphabetically ordered list of words and terms
used for referencing your text. We offer computer generated indexing
or professional indexing services. Please refer to the website for more
information.
Font type and line spacing
For text in the body of your manuscript, we recommend using Garamond font in
11-point size, single spaced. You can request a different font or spacing to be used
in your final book, but these are our default settings. Make sure to put headings of
the same level in a uniform typeface, font size, and alignment throughout your
manuscript.
Example: (A manuscript might be organized in the following way)
Chapter titles: Adobe Garamond 22-point, center aligned
First-level subtitles: Adobe Garamond 18-point, left aligned
Second-level subtitles: Adobe Garamond 15-point, left aligned
Manuscript length
Make sure that your book has at least 48 pages (8.5" × 11" pages), 10,000 words,
or 22 poems. Also, please note that our page maximum is 740 pages (or 828 page
maximum for the 8.25"x11" trim size).
Page size
You will be required to choose the trim size for you book from one of the
following:
5" × 8"

5.5" × 8.5"

6" × 9"

7.5" × 9.25"

8.25" × 11"

6" × 9" is the most common size for trade paperbacks as well as the most popular
choice among our authors. If you’re not sure what book size would best suit your
work, spend some time at your local bookstore and identify the sizes of other
books in your genre.
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Please Note: The hardcover and paperback trim sizes must be the same.
Our hardcover format is only available in the 5.5" × 8.5" or 6" × 9" trim
sizes. As such, if you have the hardcover format, you may select only one of
these two options (which will be the size for both formats).
Headers & page numbers
Your book designer will create these elements of the book layout during the design
process. Occasionally an author manually types his/her name, the name of the
book, the page number, or any combination of these at the top or the bottom of
each page. This usually happens when the author is unaware of their word
processor’s header/footer function, which automatically places this information at
the top or bottom of every page. Manual page numbers and headers create similar
issues to hitting the enter key at the end of every line, and removing them can be
difficult and time-consuming. To avoid this issue, please do not include any
header/footer information in your manuscript.
Margins
Margins are the white space that surrounds text on a page, including headers and
footers, as well as the “gutter” space for the book’s spine. When a manuscript is
converted from an 8.5” x 11” size document into a different size, such as 6” x 9”,
the margins will change. Often times this will cause text to shift or lines to break
differently from the original manuscript, and you need to be aware of this. Your
book designer can compensate for these changes, but this shift can cause issues if
you have done extensive formatting to your manuscript. If you know your book
size in advance, you can set your margins two ways:
Option A: (Best for novels, or books with all free flowing text)
You can format your manuscript on an 8.5" × 11" page with 1" margins all around
(the default settings in Microsoft Word). During the production process, we will
format your manuscript to your chosen trim size.
Option B: Best for poetry or non-fiction books with tables, graphs, or images.
You can format your manuscript to the margins that will appear in your proofs.
This option will provide you with the exact area that we can print your text on a
page. You can then lay out your manuscript knowing that there will only be only
slight changes between your manuscript and your designed proofs, which is
especially helpful for when tables and/or text boxes. For example, a table spanning
the entire width of the page in the default 8.5x11 setting of Word would be larger
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than the entire width of a 5x8 book. Here are the margins for our most common
trim sizes:
Top
Bottom
Left
Right
Header
Footer
Gutter

5x8
2.25
2.25
2.38
2.38
2.00
2.00
0.13

6x9
1.75
1.75
1.88
1.88
1.50
1.50
0.13

Here is the process for setting your margins for a 6x9 book.

Go to your Microsoft Word toolbar:
File -> Page Setup
On the Margins tab insert the appropriate
margins specified for your trim size. Here
you can see an example of a 6x9 margin
settings.
On the Margins tab insert the following
numbers: Top - 1.75, Bottom - 1.75, Left
- 1.88, Right - 1.88, Gutter - .13
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8.25x11
1.00
1.00
1.13
1.13
0.75
0.75
0.13

Creating your own Print Ready PDF
As an AuthorHouse author, you have the option to submit a press-ready PDF
instead of a Microsoft Word document. But before you choose this option, there
are a few things you need to know.
Please review this important information regarding print-ready PDFs.
Pros:
• You would not be required to submit your images as separate files or pay
any additional production fees.
• Your book’s interior will be published just as you submit it, so you have the
ultimate control over the design and layout.
Cons:
• Your PDF must meet our printing partner's technical requirements.
• We are unable to make changes to a PDF, so you will need to ensure that the
file you submit is exactly how you want your published book to look. If you
discover mistakes in your PDF after submitting it, you will have to make
changes to your original file and resubmit an error-free PDF; this
resubmission requires a $50.00 fee.
• ePub files cannot be created from PDFs. This means if you submit a PDF,
we will be unable to digitally format your book for eReaders, such as the
Amazon Kindle, Barnes & Noble nook™, etc.
Submitting a print-ready PDF ultimately gives you more control over the layout,
but it also gives you greater responsibility. If you are still interested in this option,
please let your Check-in Coordinator know and they will send you resources on
how to create a print-ready PDF.
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Spaces and Breaks
In the sections that follow, we’ll provide examples of how formatting marks should
appear on a correctly laid-out manuscript. There are three ways to view these
formatting marks on your screen in Microsoft Word:
1) Hold down Ctrl and Shift keys while pushing the 8/* key
2) Select the Tools option in your taskbar
a. Then select Options
b. On the View tab window that appears, under Formatting Marks, check
All.
3) click the ¶ show/hide button on the toolbar.
Body Text & Hard Returns
In the main body of your manuscript, let text automatically flow from one line to
the next and from one page to the next. Please hit Enter only at the end of each
paragraph. Pressing Enter to move the cursor to the next line or page (known as a
hard return) will cause spacing problems when your manuscript is formatted into
its final book size.
Incorrect:

Correct:
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Paragraph indentation
The first paragraph of each chapter or section should not be indented, based on
industry standards. However, every subsequent paragraph should be indented and
here is the proper way to do so:
1) Select the Format option in your taskbar
a. Then select Paragraph
b. In the window that opens, under “Special” Select First Line and .5

** Do not use the space bar or the TAB key to indent paragraphs, as this will
throw off the layout of the final book.
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Offset (Blocked) text
To present block quotations or to offset other text, such as journal entries or letters,
use the indentation settings in your word-processing program. Select with your
cursor the entire paragraph you would offset. Then follow the following steps:
1) Select the Format option in your taskbar
a. Then select Paragraph
b. In the window that opens, under “Indentation” section you can
increase the Left and Right margins as you desire. This create the
block effect
c. You may also wish to alter the alignment under the “General” section
to “Justified” instead of “Left” for a better block effect.
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Page breaks
To start a new chapter, section, part, volume, or book, use the page break function
in your word-processing software. In Microsoft Word, put your cursor before the
text that should start on a new page (or wherever you want to insert a new page),
then select Insert from the taskbar. Select Break from the menu that appears, then
click the Page break option (see below).

Note: Only use the “Page break” Break type option, not the “Section break types”
When using this option, your section break and new chapter will appear like this:
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Punctuation
Quotation marks
Use curly quotation marks (“ ”) with no space after an opening mark or before a
closing mark. Use straight quotation marks (") only for inch measurements.
Similarly, single quotation marks (') should be used only to indicate measurements
of feet.
Spacing with punctuation
Use just one space after all ending punctuation marks, including periods, question
marks, exclamation points, and colons.
Dashes and hyphens
Do not insert spaces on either side of a dash or hyphen. Hyphens and both types of
dashes should be flush with the text on either side.
An em dash (—) is often used to denote a shift in thought that causes an
abrupt change in a sentence. It can also be used to indicate a sudden break in
dialogue.
To enter an em dash in Microsoft Word, simultaneously hold down the Ctrl
and Alt keys while pressing the minus key on the number keypad. Or, hold
down the Alt key while typing 0151 on the number keypad
Examples:
• Eric—having just discovered the letter—ran down the street.
• “Well, I don’t know,” he began tentatively. “I thought I might—”
• Darkness, thunder, a sudden scream—nothing alarmed the child.
An en dash (–) is shorter than an em dash but longer than a hyphen. The
principal use of the en dash is to connect continuing, or inclusive,
numbers— dates, times, or reference numbers.
To enter an en dash in Microsoft Word, hold down the Ctrl key while
pressing the minus key on the number keypad. Or, hold down the Alt key
while typing 0150 on the number keypad.
Examples:
• 1968–72
• 10:00 AM–5:00 PM
• 1 Cor 13:1–3
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A hyphen (-) is used to separate numbers that are not inclusive (such as
phone numbers) as well as some compound words.
Examples:
• 1-965-386-1110
• the well-known writer
The only time space should appear after a hyphen is when the second part of
a compound word is repeated and can therefore be omitted.
Examples:
• five- to ten-minute intervals
• the six- to nine-foot height
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Additional Manuscript Elements
Bulleted and numbered lists
To create bulleted or numbered lists, please use the bullets and numbering feature
in your word-processing program. In Microsoft Word, this feature is located under
the Format menu in your taskbar. Be sure that each level of bullets or numbers is
consistently indented or aligned.

Illustrations, photos, and other graphics
To better facilitate your submission process, we recommend that you minimize the
file size of your manuscript as much as possible by providing each graphic in
separate file. (Graphics include photos, charts, diagrams, drawings, etc.) Each
graphic file should be submitted in grayscale, have a resolution of at least 300 dpi
(dots per inch) and be in the TIFF (.tif), JPEG (.jpg) or PDF format. In your
manuscript, you should specify the file name and caption of each graphic in its
correct location. For more information on graphics, please refer to the Image
Optimization Guide.
Example
My mother was born October 2, 1883, in Adair, Iowa. When she was ten
years old, her family moved to Omaha, Nebraska. Her lineage linage
traces back to England.
<<{Insert graphic 2 – 3”x3”. Caption: Pictures of us at the airport>>
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Tables
To insert tables, either with or without visible rules (or lines) use the table feature.
In Microsoft Word, the Table menu is visible on your taskbar. Do not use the
space bar or tabs to create tables; if you do, once your manuscript is reformatted to
its final book form, they will not show up as you intend.
Please Note: We strongly recommend that you do not insert tables into your
manuscript. However, if your manuscript requires there to be a table please
also submit them separately as a graphic.
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Footnotes and endnotes
To properly create footnotes and endnotes, use the footnote or endnote feature in
your word-processing program. Place the cursor in the text where you want to
insert a footnote, then take the steps below. Under the Insert menu on your taskbar,
select the Footnote option. In newer versions of Microsoft Word, you may first
need to select the Reference option under the Insert menu; select Footnote from
there.
Please Note: Additional fees may occur for endnotes or footnotes. Please
contact your CIC for more information.

b. On the box that pops up, select Footnote or Endnote, as appropriate and then
click Options… to set the details of the note.
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c. The numbering of footnotes and endnotes should start over in each chapter. If
you have appropriately separated your chapters with section breaks, as outlined
earlier, you can make sure your notes are numbered this way by selecting Restart
each section.

d. Once you have selected the appropriate system of numbering, click OK to insert
the footnote or endnote into your manuscript. A superscript number will appear
where your cursor is in the text, and a space will pop up at the bottom of the page
to let you enter the text of the note.
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Frequently Asked Questions
What is the best way to submit my manuscript?
Since all work is completed on a digital platform, we prefer to receive your
manuscript as an electronic file. Submitting your manuscript as a Microsoft®
Word or Adobe® InDesign® is best, but a complete list of accepted file formats is
available in this guide. When it comes time to actually send in your manuscript,
please contact your CIC for more information.

Can I submit a hard copy of my manuscript?
We can accept a hard copy of your manuscript, but it will require additional time
and fees to convert into electronic form. If you decide to submit a hard copy we
will data enter, or type up, the entire document. This process can take up to two
months and is offered at a per-page cost.

What is a hard return?
A “hard return” is also known as the “enter” or “return” command on your
keyboard. It is most commonly used to separate paragraphs within a document. In
Microsoft® Word, and many other word processing programs, it will display as the
“¶” character when hidden characters are displayed. To see this symbol, click on
the “¶” button on the toolbar, which will also display other “hidden characters”
such as tab markers and spaces.
A common misuse of the “hard return” is to place it at the end of a single line of
text in order to begin the text on the next line – such as one would have done with
a typewriter. This can cause “bad paragraph breaks” within a document, making it
difficult to determine where your paragraphs begin and end. Manuscripts that
incorrectly use “hard returns” may incur extra production fees, or may not be
usable. To avoid this issue, begin a new paragraph and continue typing until the
paragraph is complete, allowing your program to break the lines automatically.

Will my book look exactly like my submitted manuscript?
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When you submit your file in an 8.5” by 11” page size, the standard margins will
need to be adjusted to fit your chosen book size. When the margins are shifted, less
room will be available on each page and your overall page count will likely
increase. If you have edited and designed the manuscript yourself and would like
your book to reflect your exact manuscript, you can submit your book as a printready PDF file.

What happens after my manuscript is submitted?
Once we receive your manuscript, we will review your work to ensure the file
format is acceptable and there are no other submission issues. You will be
contacted by your Publishing Services Associate to discuss the next steps in the
process.

What if I have formatting requests that were not addressed in this
guide?
You can list any additional formatting requests on a “Special Formatting Request”
form and submit it to your Publishing Services Associate.
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